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Chapter 1. Introduction 

Forward 
Winscore was developed to calculate scores for soaring contests in the United States.  Its 
major features include: 

o Management of contest information, turnpoints, contestants, flight logs… etc. 

o Advanced task-planning functions including graphical display of proposed tasks. 

o Automatic analysis of GPS flight logs and determination of achieved turnpoints, 
roll, start, finish and landing times. 

o Analysis of Turn Area Tasks and determination of the most favorable fix at each 
turnpoint. 

o Flight log checking for Airspace violations. 

o Graphical display of flight logs, both overhead and barogram views. 

o Calculation of scores according to current United States regional and national 
rules. 

o Printing of scoresheets & exporting scoresheets to the SSA. 

Winscore’s main goals are to reduce the workload of contest organizers and provide 
timely, accurate scores to contestants and Internet users.  In order to achieve these goals, 
it is imperative that contest organizers who use the program contact the author at the end 
of the contest and provide a list of any problems that were encountered while scoring the 
contest and a list of future enhancement ideas.   

Only by providing accurate and detailed reports of problems and enhancement 
suggestions can the program be improved for future contests. 

Usage Fee 
A fully functional version of Winscore is provided to the soaring community without 
charge.  However, the development, maintenance and support of this program have 
become costly.  While the SSA makes a contribution for national contests, it provides no 
financial support for other contests.  If you find this program useful in your regional or 
non-sanctioned contest, then please consider assisting in the support and development of 
Winscore by making a voluntary contribution for the program.   

The recommended voluntary contribution is $5 per contestant. 
Contributions should be sent by check to: 

Guy Byars 
3566 Mooney Ave 
Cincinnati OH 45208 

Please indicate which contest for which you are making a contribution. 

Such contributions are the best way to ensure that Winscore will be available for future 
contest seasons.  It is reasonable to assume that most contest pilots would not begrudge 
giving $5 in return for accurate and timely scores at a contest. 

Support 
If you have problems or questions about Winscore, you can contact the author, Guy 
Byars via email at guy@byars.com.  Time critical problems (emergencies) can be 
handled by phone at: (513)-871-2462(h) or (513)-307-1484(cell). 
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It is STRONGLY recommended that before you start scoring an actual contest, you 
spend some time to review Winscore and verify it is suitable for your needs.  That way, 
you will have time to resolve any issues and obtain support before hand.   

Program version information is available on the Winscore web page: 
http://www.gfbyars.com/winscore/ 

Conditions of Use 
By using Winscore, the user agrees to the condition that if Winscore is used for a contest 
sanctioned by the Soaring Society of America, then scores for each contest day will be 
sent to the SSA’s web site.  Preliminary results must be submitted to the SSA no later 
than 9:00 AM the following day. 
Although much care has been used in the development of this software and is believed to 
be fit for operation, Guy Byars makes no claim of freedom from operational errors of any 
kind or provides no warranty of any kind, express or implied, without limitation, on the 
merchantability or fitness for any purpose of this software. Guy Byars shall not be liable 
for any damages, whether direct, indirect, special, or consequential from the failure of 
this software to operate in a manner desired by the user. Guy Byars shall not be liable for 
the damage to any data, property, or anything that may be caused directly or indirectly by 
the operation of this software. In no event will Guy Byars be liable for any damages of 
any kind, including but not limited to any lost time or property or any other incidental or 
consequential damages arising out of the use or inability to use this software, or for any 
claim by any other party 
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Chapter 2. Getting Started 

Scoring Prerequisites 
Although Winscore was designed for an average computer user with experience using the 
Windows operating system, the advent of GPS flight recorders in contest scoring has 
made the scoring process quite complex.  Consequently, some advanced computer skills 
are necessary to successfully use Winscore with GPS flight logs.  Specifically, the user of 
the program should have mastered the following skills before attempting to score a 
contest: 

o Understand the concept that information is stored on a computer’s hard drive in 
“files”. 

o Know how to create new folders on a hard drive and copy files to and from 
folders. 

o Know how to find a file on a computer and copy that file to another folder on 
the computer’s hard drive.   

o Understand the concept of an “IGC file” which is the standard format for GPS 
flight logs used in contests. 

o Know how to edit a text file with the Windows Notepad or similar text editor, 
make changes to it, then save it. 

o Know the basics of how to connect a GPS flight recorder to a PC and transfer a 
flight log. 

o Know how to perform a backup of all contest information to a suitable location. 

System Requirements 
Although no specific computer requirements have been established for Winscore, it is 
suggested that a fairly modern Pentium class computer running Windows XP or later be 
used.   

Some useful hardware items might include: 

o An SD and CF card reader.  Test the card reader before the contest and make 
sure all the necessary drivers are installed and the reader works properly. 

o A USB-Serial port adapter.  Some older loggers require a serial port for flight 
data transfer.  However, most new computers no longer have serial ports.  
Therefore if your computer doesn’t have a built in serial port, it is advisable to 
have a USB-Serial port adapter for your computer.  Again, this device should be 
installed, configured and tested well before the contest begins. 

o A CD-ROM burner.  A conscientious scorer should make a backup copy of all 
logs and data files each and every contest day. 

Terminology 

Windows terms 
These terms describe how to use the program. 

Click - Select an item by moving the mouse pointer to the item, then pressing and 
releasing the left mouse button. 

Click and drag - Move the mouse pointer to the item, then press and hold the left mouse 
button while moving the item to another location on the screen. Release the mouse button 
when over the desired location on the screen. 
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Right-click - Move the mouse pointer to the item, then press and release the right mouse 
button. This generates a context-sensitive menu of commands for that item. 

Right click menu - A context-sensitive menu that appears when you right-click an item. 
The commands on the menu are specific to that item.  Right-click menus can help you 
more quickly execute commands on an item. 

Ctrl+key - Hold down the Ctrl key while you press a second key. For example, Ctrl+C 
means hold down the Ctrl key, press the C key, and then release both keys. 

Shift+key - Hold down the Shift key while you press a second key. For example, 
Shift+C means hold down the Shift key, press the C key, and then release both keys. 

Winscore terms 
These terms describe those found in the Winscore program and related components. 

Flight Log file (.cai or .igc file) - A file containing data generated by a GPS recorder that 
is a record of the glider’s flight. Files with a .cai extension are in a Cambridge proprietary 
format.  Files with the .igc extension are in a standard format defined by the IGC 
(International Gliding Commission). 

Flight Log Path – This is the folder on a computer where the flight logs will be stored 
during a contest.  Winscore will search this folder for a contestant’s flight log.  It will 
then recursively search any folders stored in the Flight Log Path for logs. 

GPS-NAV – This is a Cambridge Aero product such as the model 20 GPS receiver/data 
logger. A GPS unit stores a waypoint database, pilot preferences, and flight logs recorded 
by the recorder. The Cambridge Aero Explorer program can read and update all 
information stored in the Cambridge GPS-NAV units. 

Flight Declaration – In a soaring contest, a flight declaration is a piece of paper that the 
contestant uses to communicate with the scorer as to what turnpoints he had achieved 
during his flight.   The only time this is used in modern contests is for pilots to 
communicate to the scorer the turnpoints they are declaring for a MAT task. 

Model 20, Model 25 – These are Cambridge-Aero Instruments GPS-NAV products. 

Penalty – A penalty is applied to a contestant when a task objective is not met, for 
noncompliance with the rules, or for a safety violation.  This might be a reduction in daily 
score or a reduction in cumulative score. 

Scoresheet – In a soaring contest, a scoresheet is given to each contestant at the end of 
each contest day.  This is a sheet of paper containing the each contestant’s speed, distance 
and score for that day in tabular form. 

Task – A task is an objective for the contestant to achieve on a given contest day.  This 
will consist of a start gate (or cylinder) a sequence of turnpoints to be achieved and a 
finish gate (or cylinder).  The task will also include a time when the task may begin and 
other parameters appropriate for the type of task declared. 

Takeoff Grid – This is a list that specifies the order in which gliders are launched on a 
given day.  This list is reordered each day to negate any advantage in takeoff order 
throughout the contest. 

Turnpoint or Control Point - A point used for navigation by glider pilots in flight, 
defined by latitude, longitude and elevation. They also have attributes to describe how the 
pilot can use the point. 

Installation 
Winscore is only distributed via download from the Winscore web site.  To download the 
program from the Internet, follow these steps. 

1. Go to the Winscore website at http://www.gfbyars.com/winscore 

2. Scroll down to the Download section. 
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3. Follow the directions on the page to download the program. Make sure you note the 
directory where your computer saves the downloaded file. 

4.  After downloading the file, double-click the My Computer icon normally located in 
the top left corner of the Windows desktop screen. 

5. Double-click the hard drive icon, and then navigate to the directory where you stored 
the installation program. 

6. Double-click the installation program to install the software. 

The software installation procedure automatically places an icon on the desktop of your 
computer labeled Winscore. Double click this icon to start the program or go to Start 
menu to Programs, then to Winscore. 

Program Overview 
Winscore follows the standard Windows® user interface standards and consists of the 
usual windows menus and toolbars.  A picture of the Winscore window appears below. 

 

o The title bar displays the program name and the name of the contest file that is 
currently open. 

o The menu bar appears directly below the title bar.  It contains the menus of 
commands for the program. 

o The tool bar appears directly below the menu bar.  It contains an icon for each 
of the commonly used commands for the program. 

o Explorer Pane lets you view all the contest information using a Windows 
Explorer type of interface.  Many of the items in the explorer pane have options 
available using the right click mouse button. 

o The Control Bar (not displayed in above image) shows what is being displayed 
in the main window, (scores, turnpoints, contestants, flight logs… etc).  The 
type of information being viewed is shown to the right of the View: label.  
Selecting a new view from the pull down menu can change this view.  The date 
and class appropriate for the data being viewed is shown in the next two pull 
down menus.  To view the control bar, use the “View | Control Bar” menu from 
the menu bar. 

o The status bar shows a brief description of the current command or button 
under the mouse pointer.  When the mouse pointer is not over a button or 
command, the status bar will show the number of rows of information in the 
current view. 
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o Many parts of the program have right-click menus.  For example, when flight 
logs are selected in the view selector, you can right-click on a flight log and see 
a menu of functions for that flight. 

Winscore Tips & Hints 
The following information should help the scorer use Winscore more efficiently: 

o Information that is stored and managed by Winscore is indexed by calendar 
dates, rather than contest day number.  Before entering data, make sure the 
correct date is displayed on your form.  Unless changed, the program will 
always default to today’s date. 

o Much of the data in Winscore can be transferred to other Windows program by 
using the Windows clipboard.  To use this feature, simply view the data you are 
interested in, control points, contestants, flight logs, scores... etc, and then select 
Copy from the Edit menu to copy what you are viewing to the clipboard.  Then 
move to another Windows application, Word, Excel, Email... etc, and select 
Paste from the Edit menu in that application.  The Winscore data will then be 
pasted there.   

o Much of the scoring information is presented in a tabular format.  To change the 
sorting order of the rows, simply click on a column header and the rows of the 
table will then be sorted on that column. 

o The date and class selection fields in the view selector or explore pane will set 
the defaults for all forms which are date or class specific.  If you want to work 
on a specific class or day, you should set the date and class you want on the 
main window, then start working. 

o You will work through the icons in the icon bar from left to right starting with 
Control Point definition and ending up with scoresheets. 

o Use the “Tab” key to move around the data entry fields in the form.  After you 
enter data, you can simply hit the tab key and move to the next field.  For 
example or the time entry form, by simply “typing and tabbing”, then hitting 
return, all the times can be entered without ever touching the mouse. 
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Chapter 3. Contest Setup 

Flight Log Management 
When planning to score a contest, careful consideration should be given to the 
management of the contestant’s flight logs.  Even a regional contest might require that 
hundreds of flight logs be received and scored.  Contestants might deliver their flight logs 
on, thumb drive, a flashcard, or they may provide a flight recorder and request that you 
download their log for them.  Regardless of the delivery medium or the recorder 
manufacturer, each of these flight logs must be converted to IGC format and saved in a 
folder accessible by the computer running Winscore. 

You will specify in Winscore which folders will be searched for log files to be scored for 
your contest.  This is done using the form below which can be found at: 
“Flight Logs | Settings… | Flight log search folders…” 

 

 
Simply use that “Add Folder…” button to add folders will flight logs will be stored 
during your contest.  The form below shows an example of how the Perry 2011 contest 
might organize their logs. 

Note that the first folder in the list is where the logs will be stored when one of the three 
import methods (described below) are used.  If these methods are used, then for each 
contest day, a different folder should be moved to the top position in the list.   This is 
done by using the “Move Up” button. 

Winscore has three functions that may be used to automate the transfer from the 
contestant to the scoring computer: 

Import from File…– This function will allow the user to select one or more 
IGC or Cambridge CAI files from another location (floppy drive, flash card, 
network location… etc) and will copy those selected files to the “Flight Log 
Path”.  If a CAI file is selected, it will be converted to IGC format and the 
resulting IGC file will be copied to the first folder in the search list shown 
above. 

Import from Flash Card - This function will search the computer for a 
removable flash card and then search the flashcard for logs which match the day 
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being scored.  If a match is found, then Winscore will display the file name, 
contest ID and pilot’s name on the log file and prompt for confirmation. 

Import from Cambridge Logger…- This function will invoke a Cambridge 
supplied utility that will look for a Cambridge Model 10, 20 or 25 flight recorder 
attached to the computer via a cable connected to the Com port.  When such a 
recorder is found, a dialog box will be shown to select the appropriate flight log 
to be transferred.  Once transferred, the flight log will be converted to IGC 
format and saved in the first folder in the search list shown above. 

Each of the three methods above will copy the log file from the contestant’s 
media to one of the folders specified in Winscore.  Then Winscore will check 
the logs security and finally if the input log is a .cai file, it will be converted to 
IGC format. 

Starting a contest 
To start a new contest, you can either select the new contest icon from the toolbar, or 
select New Contest… from the File menu.  This will create a new .WSC file on your 
computers hard drive.  The next time you start Winscore, this file will be automatically 
opened. 

 

To start a new contest, you need to enter some basic information. 

o From SSA… - This feature will use the Internet to access the SSA’s database of 
sanctioned contests and fill in the form data from the contest you select.  You 
will be given a selection of all sanctioned contests and you can simply select the 
appropriate contest.  Also by selecting your contest here, Winscore will 
remember which sanctioned contest you are scoring and automatically select 
that contest when you import contestant information or submit scores. 
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o Contest Name & Location - Self-explanatory.  The name and location will 
appear at the top of each scoresheet. 

o Dates: – Select the first scheduled contest day in this field.  The two days 
preceding this date will automatically be set as practice days.  The practice days 
will work exactly like regular contest days, but will not contribute to the 
cumulative scores.  Next, enter the total number of days your contest is 
scheduled to run.  If your contest is set to run over several weekends, simply 
enter the number of days needed to include all the contest weekends. 

o Contest Rules - Select which version of the US rules you wish to use, National 
or Regional.  See the SSA’s web site www.ssa.org for a complete description of 
US contest rules. 

Class Selection and User Defined Classes 
Check those classes that are in your contest. 

Advanced users might want to change the scoring rules or rename the class to something 
like “Senior Class” or “Club Class”.  This is done by clicking on the class you want to 
change, and then click the “Properties…” button below the list of classes.  Or you can 
simply double click on the class you want to change.  The options in the class properties 
property pages are either self-explanatory or they reference the section of the US contest 
rules to which they apply. 
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WARNING:  The FAI and Sports classes are set by default with the correct US 
contest rules.  If you are scoring a sanctioned US contest, you should not change 
them. 

Contest Settings  
Contest settings are a group of miscellaneous options that permit you to control how your 
contest is scored. 

 
o Control Point Coordinate Format - Select which latitude/long format you 

wish to have the program use by default. 

o Distance Units - Although the United States rules are all specified in statute 
miles, use this option to have program distances and speeds displayed in other 
units (Km or Nautical Miles) for task evaluations or speed comparisons. 

o List guest contestants at the bottom of the scoresheet - This option will 
permit you to have all the guest contestants listed at the bottom of the 
scoresheets. 

o Allow two start gates – At very large contests, it is desirable to have two start 
gates active in order to reduce congestion while contestants are starting their 
task.  Checking this box will enable options in the contestant entry and task 
specification to permit the selection of two different start gates. 

After the contest has been created, you can change the contest information by selecting 
Setup… from the Contest menu. 

Control Point Management 
Contest Control Points, more commonly known as “Turnpoints”, can be entered and 
managed from the Manage Control Point form.  This can be brought up by either the 
“Manage Control Points” Icon, or selecting Control Points... from the Contest menu 
pick. 

While an entire list of control points can be entered manually from this dialog, it has 
become much more common for the scorer to just import control points from a disk file.  
Winscore can read a list of control points from a file that is in the Cambridge .dat file 
format. 
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Each control point consists of the following data: 

ID - Each control point has an id associated with it.  This can be a number from 
1-500.  The program can only handle a maximum of 500 control points. 
Name - A unique name for the control point 

Latitude & Longitude - Self-explanatory.  The format is defined on the Contest 
Setup dialog. 
Attribute - This indicates whether the control point is the home airport, a start 
point, finish point, an established airfield, turnpoint or any combination thereof.  
It is very important to correctly indicate the home airfield and the start and finish 
points.  The elevation of the control point flagged as the home airfield is used to 
calibrate the pressure altitudes when using flight loggers.  Also, only those 
control points with the start and finish attributes are available to be selected 
when specifying start and finish gates in a task.  Control points with the Airfield 
attribute set are used to determine if the airfield bonus should be applied. 

Elevation – This is the elevation of the control point above mean sea level in 
feet.  Great care should be taken to ensure the control points with the start, finish 
and home attributes have the correct elevation.  The elevation of the Home 
control point is used to calibrate pressure altitude for each contestant.  The 
altitude of the Start points is used to calculate the top of start cylinders.  This 
height is used to calculate start times when contestants start “out the top” of the 
cylinder.  It is also used to calculate penalties when the contestant spends too 
much time above the start cylinder before his final start. 

The buttons on the control point management dialog perform the following functions: 

Add/Modify – Depending on whether you are about to add or modify a control 
point, this button will show either the “Add” text or “Modify” text.  When a new 
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control point’s ID, name, position and attributes have been entered, the Add 
button will create a new control point in the list.  If the ID number matches an 
existing control point in the list, then the Modify button will modify that control 
point. 

Delete - When a control point is highlighted in the list with the mouse, it can be 
deleted, or removed from the list by either clicking on this button, or hitting the 
“Delete” button on the keyboard. 

WARNING:  Deleting or changing control points after tasks have been 
entered could cause the program to no longer work correctly.  Use extreme 
caution when changing the control points after contest scoring has begun. 

Import... - As a convenience, instead of manually keying in all the control point 
data, you can read that information from a disk file.  The currently supported file 
format is that which the Cambridge Aero Instrument (CAI) software creates for 
its GPS-NAV equipment.  To import control points, simply select the CAI 
control point file.  The ID’s, names, positions, attributes and elevations in that 
file will all be read.  Note:  If you have already created some control points, any 
control points imported with the same ID, will replace the ones you entered. 

Cancel - Cancel will dismiss the Control Point Manage form and discard any 
control points you may have entered, changed, deleted or imported.  

Close - Dismiss the form and keep the changes to the control point list. 

Control Point Distance Grid 
Selecting either the control point distances icon, or selecting Control Point Distance 
Grid in the view selector will show the control point distance grid.  This will show 
distances and true courses between each control point. 

Printing of the distance grid is not supported in Winscore.  However, you can copy the 
distance grid to the Windows clipboard by selecting the Copy command from the Edit 
menu while viewing the grid.  Then you can start a spreadsheet or word processor, 
"Paste" the grid into that program, and print from there. 

Contestant Management 
Contestant information can be entered and changed from the Manage Contestant form.  
This can be brought up by either the “Manage Contestant” Icon, or by selecting 
Contestants from the Contest menu.  You can sort the contestants displayed in the list 
by simply clicking on the column headers.  The rows will then be sorted by the value in 
that column. 
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Each contestant will have the following data: 

ID - A unique 1-3 letter/number identifier identifies each contest. 
Class - A contestant is entered in one of the classes set on the contest setup 
form. 

Personal – First, last middle names and address are self-explanatory.  Check the 
box next to “Guest” if the pilot is to be scored as a guest.  Check the box next to 
“Foreign” if the pilot is not a US citizen or permanent resident of the USA.   
Glider - The model of glider is required to be entered.  This is a dropdown list 
that contains a list of the most popular gliders.  As you enter the name of the 
glider, a glider name will be suggested which matches what you have typed in 
so far.  Once a name has been suggested, you can press the up and down arrow 
keys to select similar models. 

Handicap - The handicap factor is to be entered if the pilot is a member of a 
handicapped class.  The “Lookup…” button will bring up a dialog form where 
you can select the glider manufacturer and model, then change the span, weight 
and winglet height to get an updated handicap value. 

Motorized - This checkbox indicates that an operational motor is currently 
installed in the glider.  If checked, then motor noise will be monitored and 
reported during flight log analysis. 

SSA Number – Enter the SSA number of the contestant here. 
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Withdrew - This checkbox indicates that a contestant withdrew from the 
contest.  If checked, a "W" will be listed in the remarks of subsequent 
scoresheets. 

Start Gate Group – Select which start gate group the pilot belongs.  If this 
option is not active, make sure the “Allow two start gates” checkbox is checked 
in the contest setup dialog. 

The buttons on the contestant management dialog perform the following functions: 

Apply - When a Contestant’s name, ID, and other information have been 
entered, the Apply button will create a new contestant in the list.  If the ID 
matches a contestant already in the list, then the Apply button will modify that 
contestant’s information. 

Delete - When a contestants entry in the list is highlighted with the mouse, it can 
be deleted, or removed from the list by either clicking on this button, or hitting 
the “Delete” button on the keyboard. 

Import From SSA… – Winscore has the capability to access the information 
that the contestant entered when he registered for the contest on the SSA 
website.  When this option is selection, the following 
dialog:

 
From this dialog select your contest, the press the “Get contestants from ssa.org” 
button.  This will then download the contestant information and display it on the 
dialog box.  After reviewing this information, pressing the “Import” button will 
import the contestant information into Winscore for scoring. 

Cancel - Cancel will dismiss the Contestant Manage form and discard any 
contestant information you may have entered, changed or deleted.  

Close - Dismiss the form and keep the changes to the contestant list. 

Takeoff Grid 
Winscore calculates takeoff grid positions for each day and each class in the contest.  The 
first day’s positions are selected randomly.  Positions for subsequent days are assigned by 
taking the first 20% of the contestants for a class and moving them to the end of that 
class.  Note: When you recalculate the list, any existing grid positions will be discarded 
and replaced by a new list. 

To calculate the grid positions, bring up the Takeoff Grid Calculation form by either the 
Takeoff Grid Icon, or selecting Takeoff Grid Positions in the Contest menu, select the 
class, and hit the calculate button.  The resulting grid positions can be viewed on the main 
window or printed.  The status of whether or not the grid positions have been calculated 
is displayed on the form. 
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When the takeoff grid positions are displayed in the main view window, you can use 
Copy from the Edit menu to copy this information to the Windows clipboard.  Once on 
the clipboard, you can go to a word processor or spreadsheet program and use the Edit | 
Paste menu there to insert the takeoff grid into that application.  You can then change the 
grid and then print from that application. 

To print grid sheets simply select either the print or print preview commands while 
viewing the takeoff grid positions in the main view window. 

Printing Takeoff Grid Sheets 
Contest gridding varies widely from site to site.  The grid sheets generated by Winscore 
are hopefully general enough to satisfy most contest organizers and pilots.  However, if 
for some reason, Winscore can't generate a satisfactory grid sheet, you can use Copy 
from the Edit menu to bring the takeoff grid into a word processor or spreadsheet where 
you can change it to something suitable for your contest site. 

It is recommended that you make extensive use of the Print Preview command to make 
sure the grid is acceptable before you start making paper copies. 

When you begin printing or previewing grid sheets you will see this form: 

 
Each item on the form is outlined below: 

Number of Days to Print - A grid sheet is printed for each contest day.  For each 
subsequent day, the top 20% of the contestants in a given class are moved to the end of 
that class.  Enter here the number of days you want to print. 

Starting Grid Number:  This is the number assigned to the first glider to take off for a 
day.  Subsequent gliders will be incremented by one. 

Contestants in each row:  The grid sheets are printed in tabular form.  This number 
controls the number of contestants to be displayed in each row. 
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Use Letters for Columns and Numbers for Rows:  Some contests assign grid positions 
using both numbers and letters.  For those contests, this option will assign the grid rows 
with a single number and the position in that row is done with a letter.  

Spaces between classes:  For contests with multiple classes,  this is the number of empty 
grid positions used to separate the classes. 

Class & Contest Day List:  The classes in the contest will appear in the class list.  
Classes with a check mark beside them will be included in the grid sheet.  This list also 
defines the order in which the classes appear in the grid.  For example, in the above 
example, the grid will be ordered by Standard, 15 Meter then Sports class.  If you want to 
change this order, simply click on the class you want to change, then hold the mouse 
button down and "drag" the class to the desired position. 

“Day +” & “Day –“ Buttons:  These buttons change the values in the Contest Day 
column.  This controls which contest day the printed grid sheets starts with.  Typically, 
all the classes will have the same day.  However, if one class has a contest day, while 
another day does not, new grid sheets will be required with different contest days for 
different classes.  To change the contest day for a class, click on that class with the 
mouse, then click either the "Day +" or "Day -" button to change it.  Note: You can select 
more than one class at a time by clicking with the "Ctrl" button held down when you 
select classes.  The + and - buttons will work on all the selected classes at once. 



20 Winscore User’s Guide 

Winscore Users Guide 

Chapter 4. Daily Contest Operations  

Task Setup 
Tasks can be entered and managed from the Manage Tasks form.  This can be brought up 
by either the “Manage Task” Icon, or selecting Tasks… from the Daily menu. To create 
a task, fill out the information for your task, then hit OK.  To modify an existing task, 
first select the class and day.   After the date and class are entered, if a task has been 
defined, it will be displayed on the form automatically. Make any desired changes to the 
task definition, then and hit OK.  An “Apply” button is also available.  This will create 
the task you defined, but keep the form active will all the times and turnpoint information 
preserved so additional tasks can be created for other classes without reentering the 
turnpoints. 

 

Class/Day Selection - Specify the class and date of the task.  The default is taken from 
the date and class on the view selector. 

Task Status- To begin task specification, first indicate that this date should be a contest 
day by clicking the status selection to “Preliminary” or “Un-official”.  The status is 
reported on the printed scoresheets. If the status is set to "Preliminary", then no flight 
information for a pilot will be printed on the scoresheet if no flight data has been entered 
for the pilot.  If the status is set to "Official" then the scores are locked for this day and 
will not be recalculated.   

Note Do not set the status to "Official" unless all the scoring for that class on that 
day is complete.  Once the status is set to Official, then the scores for that day are 
locked and will not be recomputed. 
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Task Type- Select the type of task specified for this day.  Check the SSA Contest rules to 
get more information on the specific characteristics of each task. 

o Assigned - This radio check indicates that an assigned task has been defined for 
the day.  This task requires that the pilot achieve a sequence of predefined 
turnpoints. 

o Modified Assigned - This radio check indicates that a modified assigned task 
has been defined for the day.  This task requires that the pilot achieve one or 
more of a list of predefined turnpoints.  Once all the predefined turnpoints are 
achieved, the pilot is then free to fly to additional turnpoints.  A minimum time 
is specified for this task. 

o Turn Area - This radio check indicates that a Turn Area task has been defined 
for the day.  This task, also referred to as the “Assigned Area Task”, requires 
that the pilot achieve a sequence of predefined turnpoints.  A radius is defined 
for each turnpoint and Winscore will automatically calculate which GPS fix 
within that radius produces the maximum task distance.  A minimum task time 
is specified for this task 

 
Task Times –Each task must have a Task Open time specified.  A contestant must make 
a valid start after this time in order to receive a score.  This time is entered as a local time.  
For the Pilot Selected , Turn Area and Modified Assigned Tasks, the minimum task time 
is entered here. 
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Start Gate… - This button will bring up the start gate settings form.  On this form you 
should select the control point to be used as the gate center.  Only those control point 
with the “Start” attribute set will be available for selection on this dialog.  You may also 
define the gate as being GPS controlled or not.  If GPS controlled, you can define it as 
either being a cylinder, or a conventional start line.  For a cylindrical gate, you specify 
the radius and the top of the gate.  For a start line, you enter the width of the gate.  The 
start line is centered on the gate center point.  When a GPS controlled cylindrical gate is 
defined, the first task leg will be reduced by the amount of the start radius. 

Start Gate B… - If two start gates are active for this contest, a 2nd start gate may be 
entered for this task.  Checking the checkbox to the left of this button will activate it so a 
2nd gate can be selected.  The user interface is identical to that of the primary start gate. 

Finish Gate… - This gate brings up the finish gate settings form. .  Only those control 
point with the “Finish” attribute set will be available for selection on this dialog.  The 
settings on the finish gate form are similar to those on the start gate form.  When a GPS 
controlled cylindrical gate is defined, the last task leg will be reduced by the amount of 
the finish radius. 

Note:  All start and finish gate altitudes are entered as MSL.   

 
Turnpoints: - For Assigned, Modified Assigned and Turn Area tasks, a series of 
turnpoints must be defined for the pilots to fly. 
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In the Turnpoints key in field, enter the ID number for each turnpoint in the task.  The 
turnpoints must be separated by either a space or a comma.  Do not enter the start or 
finish points, they should be defined using the start and finish gate buttons above.  When 
you enter a valid turnpoint, it will appear in the list below the key in field. The button to 
the right of the key in field labeled “Browse…” will bring up a form that will permit you 
to select turnpoints from a list instead of typing in the number.  To remove turnpoints 
from the list, simply delete them from the key in field.  For Turn Area task, the turn area 
radii are also entered here.  One radius should be entered for each turnpoint.  Radii are 
entered and separated by a space or a comma. 

Distance: - For Assigned, Modified Assigned and Turn Area tasks, the distance of the 
task is display for planning purposes.  For Assigned and Modified tasks, this is the sum of 
the distances of each leg.  For Turn Area tasks, a min, max and nominal distance are 
displayed.  The nominal distance is the sum of the distances of each leg.  The min and 
max distances are the approximate theoretical minimum and maximum task distance 
possible given the turnpoints specified and the radius of each turnpoint.  Distance 
reductions are made by Winscore for start and finish gate radii. 

View Task… - This command will display the task you have input graphically.  See the 
Flight Display section of this manual for instructions on how to change the view of this 
display. 

 

Penalties 
The Adjust Scores and Apply Penalties form can be brought up by either the toolbar con, 
or by choosing “Adjust Scores...” from the “Daily” menu.  This form allows you to 
apply day and contest penalties.  It also allows you to provide score adjustments. 
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Contest ID:  - Self-explanatory. 
Date: - The date the penalty will apply.  For day penalties, the penalty will be applied 
this day.  If the day turns out to be a no contest day, no penalty will apply.  For contest 
penalties, the penalty will appear only on this day’s scoresheet, but the penalty itself will 
be applied to the cumulative score. 

Adjustment - The score adjustment can be one of several types: 

o Day Point Penalty - Apply a specific number of points as penalty for this day.  
Will not exceed the total number of points earned for the day. 

o Day Percent Penalty - Apply a penalty as a percentage of the daily score.  Will 
not exceed the total number of points earned for the day. 

o Contest Penalty - Apply a penalty to be subtracted from the contestant’s 
cumulative score.  Penalty will apply regardless whether the date the penalty 
was applied was a contest day. 

o Zero Score - Override the scoring program and assign zero points for the day. 

o Score Distance Only - Override the scoring program and score distance only. 

o Use Roll Time - Override the scoring program and use contestants roll time as 
start time. 

o Enter Comment Only - Enter a simple comment without any penalty. 

Points/Percent - Number of points or percent of daily score to apply. 

Code: - A 1-3 letter code which will appear on the scoresheet to identify this penalty.  
Standard codes are available in the drop down box, you another code can be entered. 

Comments: - A more detailed description of the penalty. 

Apply - When a penalty or adjustment has been specified, the Apply button will create a 
new penalty in the list. 

Delete - When a penalty in the list is highlighted with the mouse, it can be deleted, or 
removed from the list by either clicking on this button, or hitting the “Delete” button on 
the keyboard. 
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Cancel - Cancel will dismiss the Adjust Scores and Apply Penalties form and discard any 
information you may have entered, changed or deleted.  

Close - Dismiss the form and keep the changes to the penalty list. 

Note:  The flight log analysis will only recommend start and turnpoint penalties.  
The scorer must review these recommendations and actually apply the penalty 
himself. 



26 Winscore User’s Guide 

Winscore Users Guide 

Chapter 5. Flight Log Analysis 

Introduction to Flight Log Analysis 
Winscore can analyze GPS flight logs and calculate information required for the scoring 
of a soaring contest.  Winscore determines the start and finish times, verifies the achieved 
turnpoints, and, in the event the task was not completed, will determine the point of 
furthest progress along the specified task. 

General Philosophy 
The Flight Log Management section in Chapter 3 of this manual has advice on how to 
organize the flight logs in your contest.  In general, at a contest you will follow these 
steps to analyze flight logs: 

1. At the start of the contest day, first create a task 

2. Once the contestants return, import the flight logs into Winscore 

3. Analyze the flight logs by clicking on the “Analyze All” button, or choosing 
“Analyze All” from the “Flight Logs” menu. 

4. Review any warnings that might have been generated during the analysis. 

5. Resolve any problems with flight analysis by using the “Edit Flight Log” 
function.. 

6. View the scores and make sure they are reasonable. 

Flight Log Menu 
The following selections appear in the Flight Logs menu.  Most of these choices are only 
available when the view selector is set to “flight logs” and a flight log is selected from the 
flight log list.  Note:  The menus applicable to a single flight are also available simply 
right-clicking on that flight in the flight log list. 

Settings... - This form contains program settings concerning flight logs and their analysis. 

Import... - This menu allows you to bring flights into Winscore 

Display… - This will display the selected flight overlaid on the specified task. 

View Warnings - Sometimes during the analysis of flight logs, events occur that need 
the scorer's attention.  This could be because a pilot failed to come close to a turnpoint, a 
start penalty was recommended... etc.  If there are warnings, then double clicking on the 
flight will display the warnings.  Note: The flight analysis program only suggests 
penalties; it does not apply them automatically. 

View IGC File - This menu will display the selected flight's IGC file with the Windows 
Notepad application.  You can also make changes to the IGC file from Notepad.  Extreme 
care should be taken if changing the contestant’s original IGC file. 

View Analysis... - This function allows the scorer to see how Winscore interpreted the 
selected flight. 

Check Security… This function???? 

Delete. - This function will remove the selected flight from the flight list and optionally 
remove the associated IGC file from the system.  Use this with care.  

Edit… - This function??? 

Refresh - This will look in the flights in the “Flight Log Path” for any new IGC files.  
The new files will be displayed in the flight list. 

Analyze Flight - This will analyze (reanalyze) the selected flight. 

Analyze All - This will analyze (reanalyze) all the flights. 
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Flight Log Popup Menu 
The following “popup” menu appears when you select a flight log and press the right 
mouse button. 

 
View IGC File - This menu will display the selected flight's IGC file with the Windows 
Notepad application.  You can also make changes to the IGC file from Notepad.  Extreme 
care should be taken if changing the contestant’s original IGC file. 

Analyze - This will analyze (reanalyze) the selected flight. 

Edit… - This function lets the scorer modify the results of the analysis.  It is described in 
more detail below. 

Delete. - This function will remove the selected flight from the flight list and optionally 
remove the associated IGC file from the system.  Use this with care.  

View Warnings... - This function allows the scorer to see how Winscore interpreted the 
selected flight. 

View Analysis... - This function allows the scorer to see how Winscore interpreted the 
selected flight.  This function is described in more detail below. 

Info…… This function will display additional information about the analysis. 

 
Display… - This will display the selected flight overlaid on the specified task.  See below 
for a more detailed description about this function. 

Security  - This function will let the scorer perform a security check of the selected log. 

� Check Security – This will check the flight logs security seal by using the 
security verification code provided by the logger’s manufacturer.  The result of 
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the security check will be displayed via popup messages and the in the final 
column of the flight log list. 

� Mark as Passed – This will force the log to be marked as passed.  No further 
security checking will be performed on this log.  This is useful if the security 
check for this log cannot be performed or the log check causes a problem with 
Winscore. 

� Mark as Failed - . This will force the log to be marked as failed.  No further 
security checking will be performed on this log. 

Settings 
Information required for processing the flight logs in a contest are specified as flight log 
setting.  This information can be set and changed by choosing “Settings…” from the 
“Flight Logs” menu.  There are 3 tabs on the settings dialog: 

General Settings 

 
Com Port:- This is the ID of the serial communications port used to communicate with 
Cambridge flight loggers. 

Flight loag search folders… - This will bring up a dialog that lets you enter folders 
which Winscore will search for flight logs.  It will also recursively search inside any 
folders found in this folder.  Only flight logs stored here can be used in Winscore. 

Special Use Airspace – Winscore provides the capability to check the flight log for 
airspace incursions.  Airspace must be stored in the “Tim Newport-Peace's Special Use 
Airspace Format”.  A default airspace file, “conus.sua” is installed with Winscore and 
contains all the airspace in the continental USA.   

Ignore Airspace outside contest area - By checking this checkbox, only the airspace 
within the immediate contest area will be checked by the program.  This check box 
should be used when using the conus.sua airspace file, as it will speed up flight log 
analysis.  However if you have provided your own airspace file that includes only 
relevant airspace data, then this checkbox should be left unchecked.  Only airspace which 
is displayed with the flight trace and in the task planning feature will be checked for 
incursions. 

Note:  The conus.sua airspace may be updated with future releases of the program, but no 
guarantees are made that the conus.sua file contains accurate and complete airspace 
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information about every contest site in the US.  Contest organizers are responsible for 
checking that the relevant airspace in the conus.sua file is correct, or they should create 
an airspace file of their own.  Under no circumstances should the information in this 
file be used for air navigation. 

Analysis Settings 

 
Turnpoint Radii – There are two radii needed when analyzing flight logs.  The Arrival 
Radius is the minimum distance from the turnpoint the contestant must fly in order to 
achieve that turnpoint.  If the contestant only flies within the Outer Radius then the 
turnpoint will still be achieved, but a penalty will be assessed.  For the Turn Area task, 
these radii are not used. 

Time Conversion – The times in flight logs are recorded in GMT time,  It is critical that 
this time is properly converted to local time so it can be compared with the task open 
time which is specified in local time.  There are three options for time conversion.  
Choose which one is appropriate to your situation. 

Importing Flight Logs into Winscore 
Flight logs must be converted to IGC format and must reside in a one of the folders 
specified in the flight log settings dialog before they can be scored.  The import process is 
simply a tool to help you copy a flight log from a disk file, compact flash card, or other 
media, to the “Flight Log Path” where Winscore can find it.  Winscore will 
automatically convert files in the Cambridge CAI format to the standard IGC format.  
You can import flights two different ways: 

Import from Cambridge Model 10/20/25 Recorders 
If your contestant has a Cambridge recorder, you can transfer the log directly from the 
recorder into Winscore.  This process will transfer the log from the recorder to the PC in 
the Cambridge CAI format, check security, then convert it to ICG format and save it in 
the “Flight Log Path”.  To invoke this transfer, connect to the Cambridge Model 10, 20 
or 25 unit to the PC to the serial port with a cable, then select the icon with the 
Cambridge logo to start this utility.  You can also choose “From Cambridge Logger…” 
from the “Flight Logs” > “Import” menu.  Make sure the serial communication port 
(com port) is set correctly for your computer before you attempt this transfer. 
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Import from Files 

NOTE: If your flight logs are in IGC format and reside in a folder under the “Flight 
Log Path” directory, you do not need to import them. 

If you have your flight logs in the IGC format (.IGC) or Cambridge format (.CAI), 
Winscore can import these files directly.  Simply select “Import” from the “Flight 
Logs” menu, and then select your files.  The .CAI files will be converted to IGC format, 
then copied to the Flights Directory.  If you select IGC files, they will simply be copied 
to the Flights Directory. 

Flight logs from Flight Data Recorders (or Black Boxes) can be imported directly into 
Winscore, or can be imported via IGC or CAI files generated by other programs.  Once 
the logs are in Winscore, they can be automatically analyzed for scoring data.  Roll times, 
start times, finish times, landing times, achieved turnpoints and landing locations are 
calculated from the flight log.  The "Flight Logs" menus control flight logs. 

Once the flight logs are imported into Winscore, they are stored in a directory called the 
“Flight Log Path”.  By default, this directory is a folder in the directory where you 
installed Winscore.  You can change this directory at any time by the (Flight Logs | 
Settings…) menu pick. 

Import from Flashcard… 
Winscore will continuously check for the insertion of a flashcard into your computer.  
When it detects a new flashcard, then it will check that flashcard for IGC flight logs that 
match the current contest date.  If a match is found, then you will be prompted if you 
wish to import that log.  

Bypassing the Import Process 
If you already have your flight logs in “IGC” format, and you understand how to copy 
files on a computer running Windows, you can simply copy the IGC files to any folder in 
the “Flight Log Path” directory.  These directories is by default the “C:\Program 
Files\Winscore\flights” directory, but if you didn’t install Winscore to the default location 
during the install process, look in the Flight Log, Settings page to find out where this 
directory is located.  Once you have the IGC files copied to this directory, then Winscore 
can find and analyze them.  If you do this copy yourself, you should not use the “Import” 
command. 

Viewing Flight Log Analysis Results 
The analysis of a soaring flight is a lengthy and complex procedure.  If the results of the 
analysis are not what the scorer expected, then he can view a complete and detailed 
summary of how the flight was analyzed.  To view this summary, choose “View 
Analysis…” from the “Flight Logs” menu.  This will display a table with each GPS fix 
and the following information in the columns:  

Point Number This is the number of the fix in the flight log.  It starts with 
1 for the first fix in the log. 

Time (local) This is the time from the flight log converted to local time.  
If this time is not correct, check that the times in the IGC 
file are correct UTC times.  Also check the flight log 
settings form to make sure the conversion is correct. 

Status For each fix, Winscore assigns a "status" for that point.  
For example, “Inside Start Cylinder”, “Landed”, 
“Finished”... etc. 

Average Speed This is an average flight speed calculated by averaging the 
instantaneous speed at the current fix, those at the previous 
two fixes and the next two fixes. 
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GPS Altitude This altitude was computed using only electronic GPS 
satellite signals and recorded in the fight log. 

Pressure Altitude 
 

This altitude was computed from the pressure sensor in the 
flight  

Corrected Altitude This altitude is the pressure altitude from the flight logger 
that has been adjusted with a correction based on the 
elevation of the home field.  This correction is the 
difference between the pressure altitude of the first several 
fixes in the flight log and the home field elevation.  The 
text "bf" and "as" will be appended to the altitude if the fix 
is below the finish cylinder base or above the start cylinder 
ceiling. 

Accuracy This is the fix accuracy in the flight trace.  If no accuracy 
info is included in the trace, 30m is assumed. 

Turnpoint ID If the pilot approaches within the Outer Radius of one of 
the task points, Its ID is displayed. 

Turnpoint Dist. Distance to the closest task point. (Miles) 

Start & Finish Dist Distance to the start and finish points. (Miles) 

Location Latitude and Longitude of the fix. 

Also on the view form are several buttons which let you jump to events such as start, 
finish, landing... etc. 

Flight Log Analysis Warnings 
Occasionally, Winscore will encounter a problem or irregularity when analyzing a flight 
log.  When this occurs, Winscore will generate a warning for the flight log.  The number 
of warnings is displayed in the flight log list.  Typical warnings are: 

o Missing a turnpoint by a small distance.  A penalty will be recommended in the 
warning. 

o Use of a motor when the contestant has a motorized glider. 

o A gap in the GPS trace. 

o Incursion into restricted airspace. 

If a flight log is analyzed without any warnings, you can be reasonably sure that scoring 
information was correctly determined from the flight logs.  Flight logs with warnings 
should be carefully reviewed. 

Flight Log Display  
Flights can be displayed graphically.  Selecting the flight of interest in the flight view 
display, and selecting "Display..." from the “Flight Log” menu does this.  Alternately, 
you can press the right mouse button when selecting a flight and select the "Display..." 
command from that menu. 



32 Winscore User’s Guide 

Winscore Users Guide 

 
The flight log display is divided into two parts.  The upper part shows the altitude of the 
flight as a function of time.  This is called the Barogram View.  The lower part shows an 
overhead view of the flight and is called the “Flight View”. 

Barogram View 
The blue line in the Barogram View will control how much of the flight in the Flight 
View is shown.  The red bar along the bottom of the Barogram View indicates the time 
the pilot was on course.  This is the time between the start and finish times if the task was 
completed, or the time between the start and the point of furthest progress if the task is 
not complete. 

By clicking and dragging this line with the mouse, you can see how the flight progresses 
in the lower Flight View.  The “Status Info.” at the bottom of the screen reflects the 
flight conditions associated with the time indicated by the position of the blue line in the 
Barogram View.  If the contestant has a motorized glider, then the engine noise level will 
be displayed in green in the Barogram View. 

Right clicking the mouse in the Barogram View will give you the options to zoom in on a 
segment of the flight or perform a differential analysis between two points in the view. 

Flight View 
You can change the scale, rotate and pan the Flight View display by the following mouse 
commands:  

Pan Press and hold the left mouse button, then move the 
mouse to pan the screen. 

Zoom In  Click with the right mouse button and select “Zoom” 
from the menu.  The select the upper left corner of the 
area of interest, then drag the mouse to the lower right 
area of interest and release the mouse button.. 

Zoom Out Click the right mouse and select the “Zoom out” menu. 
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Vertical Rotation You can rotate the scene about the center of the screen.  
You do this holding the shift key down while moving 
the mouse up and down. 

Horizontal 
Rotation 

You can rotate the scene horizontally.  This will rotate 
the scene about a vertical axis.  You can do this holding 
the shift key down while moving the mouse left and 
right with the shift key pressed. 

Measure To display distances between gps fixes and turnpoints on 
the map, simply right click and select the Measure… 
menu.  This will change the cursor to a ruler and you can 
select a point on the display and drag to another point.  
While you are dragging the mouse, the distance of the 
dragged line will be displayed in a box on the screen. 

Measuring between two GPS fixed will display not only 
distance, but other information such as speed, change in 
altitude, rate of climb… etc between the two fixes. 

To get the cumulative distance between several points or 
fixes, simply click on the first point, drag to the next 
point, then release the mouse button, then press it again 
and drag to the next point. 

The part of the flight trace occurring before the latest start is displayed in gray, as is the 
portion of the flight after the finish.  If the task is not complete, then the portion of the 
flight after the point of furthest progress is displayed in gray. 

You can change the display options by right clicking with the mouse anywhere on the 
display. 

Checking for Airspace Incursion  
Winscore provides the capability to check the flight log for airspace incursions.  Airspace 
must be stored in the “Tim Newport-Peace's Special Use Airspace Format”.  The format 
for this airspace file is listed in the appendix.  The file is specified in the flight log 
settings dialog.  This airspace will be shown whenever a flight log is displayed. 

If an airspace incursion is detected, it will be listed as a warning in the flight log view.  If 
this warning is encountered, then the flight should be carefully viewed graphically to 
check this incursion. 

Note: Winscore only checks the penetration into the lateral boundaries of the 
defined airspace.  It does not check if the pilot climbed or descended into the 
restricted airspace. 

Editing Flight Log Analysis Results 
Occasionally, the flight log analysis will not give the correct or desired result.  The most 
common use of the Edit… command for flight log analysis is to correct the MAT 
turnpoint selection.  This feature can also be used to select a different start time, finish 
time or landing time. 

Once a flight has bee edited, a double asterisk “**” will appear in the status field of this 
flight in the flight log list.  This is to indicate that the flight has been manually edited.  To 
clear the edits, simply right click on the log and select “Analyze”.  This will clear all 
manual edits and reanalyze the flight.  Not that when an “Analyze All” is performed, any 
flight logs with manual edits are skipped and not reanalyzed. 
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Completed Task –  Click this box if the pilot completed the task. 

Safety Finish – If the CD declared a “Safety Finish”, then check this box.  Check the 
SSA rules for a description of the Safety Finish. 

Turnpoints – Check this box if you need to change the achieved turnpoints.  Note this 
will only be available for MAT tasks.  Once this box is checked, then you can enter the 
achieved turnpoint list. 

Landout Info – You can enter the contestant’s landing location here.  For MAT tasks, it 
is important to make sure the “While Attempting” turnpoint is set correctly.  An alternate 
way to specify the landing location is to determine which time is associated with the 
desired landing location and set that time in the “Landed” field on the dialog. 

Distance – This field is used to manually override a distance for the contestant. 

Recalculate – This button will recalculate and reanalyze the flight log using the scorer’s 
input on the form. 

Times – The Roll, Start, Finish and Landing times can be overridden by checking the 
appropriate check box and entering the correct time.  As was mentioned above, an 
alternate method of entering a landing point is to enter the time associated with the 
desired landing point in the Landed field. 

Select Alternate Start Time… - When a start penalty has been detected, this button will 
bring up a dialog box that will give the scorer information to let him select the most 
favorable start. 

Change Turnpoint Fixes –  This function brings up a dialog with a graphical 
representation of each turnpoint.  The  scorer can change which fix is used for each 
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turnpoint.

 
To use this function, first select the turnpoint of interest.  Then select the Change+ or 
Change- buttons to select different fixes.  The distance field will be updated with the task 
distance using the current point. 

 

Troubleshooting Flight Log Analysis 
 
I import the flight log, but I don’t see it in the flight log view. 

Check the following: 

o When viewing the flight logs in the flight logs view, make sure the date and 
class selectors are set correctly. 

o Make sure the file containing the flight log conforms to the IGC file naming 
convention.  This convention is listed in the appendix.  If this IGC file is using 
the short name, then the first 3 letters in the file name must represent the contest 
date.  If the flight log is using the long file names, then check the IGC 
specification to see if the name is correct.  The file must be properly named to 
be recognized by Winscore. . 

o Make sure that your flight log is present in the “Flight Log Path” or a folder in 
it.   The “Flight Log Path” is set in the Flight Log Settings.  Winscore only will 
recognize IGC files and only if they are in the flights directory.   

If the above 3 conditions are met, you will see your flight log in the list.  

 

A pilot is listed as “Not a Contestant” in the flight log view 
The contest ID or the glider ID in the IGC file must match that of a contestant 
defined in the contest.  Otherwise, the pilot will be listed as not a contestant.  
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You should check the contest ID listed in the IGC file.  To do this, right click on 
the flight in question and select the “View IGC File…” menu.  This will bring 
up the Notepad editor where you can view the contents of the IGC file.  You can 
correct the contest ID in the IGC file.  Changing the IGC file should be done 
with extreme caution. 

 
I try to import a file directly from a Cambridge flight recorder, but I got errors or 
nothing happened. 

Check the following:  

o Is the com. port ID is set correctly for your system?  Is the recorder is turned on?  
Is the recorder manufacturer set correctly for the recorder?  Not all recorders are 
supported in Winscore. 

o Is the Flight Log Path correct?  You can check this by looking at the flight logs 
settings. 

o If problems uploading the flights from the recorder continue, use the 
manufacturer supplied upload program to create an IGC file on a disk file, then 
import that file into Winscore. 

 
I imported a flight and it seemed to go ok, but it didn’t tell me if the contestant 
completed the task or not. 

The import process only brings the flight into Winscore.  You must then go to 
the flight log view display to see the results of the analysis. 

 
The times for a pilot appear to be one or more hours off. 

Check that the time recorded in the flight log is UTC time, and the time zone 
entry in the IGC file is correct.  By default, Winscore converts the UTC time in 
the flight log to local time by using the Windows system time zone.  You can 
change this by selecting Settings from the Flight Logs menu and setting the 
option to convert the UTC time by a user defined time offset. 

 
The flight log view displays some information, but it seems like it should show more. 

At the bottom of the flight log view, there is a slider bar.  Slide that bar to the 
right and you will see more information. (Someone actually asked this one.) 

 

The analysis did not calculate the achieved turnpoints correctly. 
If you feel the turnpoints were not calculated correctly, you can change them in 
the Edit… function. .  The information entered in the edit dialog will override 
that which was calculated by the analysis. 
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Chapter 6. Scoring 

Score Calculations 
Scores are automatically calculated each time the scores are viewed.  You view the scores 
by selecting “Scores” in the view selector. The scores are calculated by the United States 
rules for regional and national contests. 

Troubleshooting Scoring 
If there is any question or confusion about the scores calculated by Winscore, the very 
first thing you should do is to view the scoring calculation information.  This is done by 
clicking on the icon with the lower case yellow “i”, or by choosing “Scoring Calculation 
Info…” from the “View” menu.  This will bring up the dialog box show below: 

 
From this dialog you can see all the important parameters that are used in the scoring 
formula.  Also if there is any missing or irregular data for a contestant, it will be listed 
here. 

Also, if scores seem incorrect or confusing for a particular contestant, check if there is a 
landing card entered for him and make sure it is correct.  Also check that any times 
entered for this pilot are correct. 

Printing Scoresheets 
Once you are satisfied with the scores, they can be printed.  First, however, it is a good 
idea to view the scoresheet with the “Print Preview” command to make sure everything 
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looks correct.  Then use the standard windows “Print…” command to create your 
scoresheet. 

Winscore does not support the printing of a cumulative scoresheet.  However, the 
cumulative scores can be copied to another Windows Application, (Word, Excel… etc) 
and printed there. (See below) 

Copying Scoresheets to other Windows Application 
One of the powerful features of Winscore is the ability to move information, scoresheets, 
contestant lists, turnpoints… etc between other Windows Applications. 

Scoresheets can be transferred to another Windows application by copying it to the 
Windows clipboard, then pasting it while in that application.  When you select the 
“Copy” from the “Edit” menu, you get the following dialog. 

 
Separate Columns with Tabs – It is often desirable to have a scoresheet’s columns 
separated by the tab character.  This will make it easier to convert it to a tabular format in 
word processors and spreadsheets. 

Copy contest summary – This will instruct Winscore to copy a contest summary 
scoresheet to the clipboard instead of a regular daily scoresheet.  The summary shows the 
results of each contestant on each contest day.  Once the scores have been copied simply 
switch to another application and select Paste from the Edit menu 
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Chapter 7. Contest Results 

Introduction to Contest Results Reporting 
Nothing marks a contest organization as amateurish more quickly than the failure to post 
timely results to the soaring community.  With the widespread availability of Internet 
email, there is NO EXCUSE for failing to send the scores to the SSA each day.   

One of the conditions of use of Winscore is to post scores to the Internet no later 
than 9:00AM the morning following the contest day 

Posting Scores to ssa.org 
When you are satisfied with the daily scores you should send them to the SSA.   

Note: Nothing marks an amateurish contest organization more clearly than long 
delays submitting scores to the SSA! 

 

Beginning in 2011, Winscore is now integrated with saa.org and will permit the 
automatic transfer of scores to www.ssa.org.  This automatic transfer is done with the 
menu “Daily | Send to SSA website…”, or you can click on the rightmost icon on the 
toolbar. 
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In this form, you specify your contest name from the contest list.  If you used the “From 
SSA…” feature when you created your contest, this will be selected automatically for 
you.   If your contest is not in the list, please contact the SSA.   

You will next want to specify the date, classes and what you want to send to the SSA.  
You have the following 3 choices: 

� Daily Scores – This is the typical daily scoresheet that should be sent each day 
to the SSA. 

� Daily Flight Logs – This feature will take the flight logs for the specified day, 
compress them into a .zip file, and then transfer them to the SSA.  When you 
transfer logs, you have the following options: 

 
 
These options will let you select and condense the logs which you send to the 
SSA.  You have the choice to select only the top few pilots and also how you 
want to condense the .igc files.  

Minimum time between fixes - Typically, flight data recorders save a fix at 4 
second intervals.  However, if the .zip file contained every fix that each pilot 
made for the entire day, the .zip would be too large to send efficiently.  
Therefore, the scorer can set a new time interval that is used to create the .zip.  If 
the time interval entered here is larger than what the pilot used during his flight, 
then some of his fixes will be ignored when his flight is put into the .zip.  Using 
a short interval will give more detail to the Internet viewer, but will increase the 
.zip size and using a longer interval will give less detail to the internet viewer, 
but will decrease the .zip size.  Testing has show that a 15 second interval to be 
a good tradeoff between resolution and file size. 

Exclude Pilots… - For whatever reason, some pilots might not wish to have 
their flights viewed by others.  For those pilots, simply click on this button, and 
then uncheck their name in the pilot list.  Once this checkbox is unchecked, a 
pilot will remain excluded from all subsequent flight log exports until his name 
has been checked again. 

� Contest Summary – When the contest is complete and all the contest days are 
marked as official, then you want to send a summary one time to the SSA. 

When you have finished setting up this form, you should then press the “Send to Server”.  
You will then be prompted for the submission username and password you received from 
the SSA. 
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And obviously, you can have Winscore remember your username and password by 
clicking the appropriate check box.  When the scores are successfully transferred, you 
should get the following confirmation: 

 
Any problems in the transfer will be reported and problems should be corrected before 
resubmitting the scores. 

 

If for some reason you cannot use this feature, and it better be a good reason, you can 
always use the old method of exporting the scores to a text file and manually submitting 
them to the SSA web site. 

To start the export process click on the SSA icon on the toolbar or choose 
“Scoresheet…” from the “File > Export” menu. 
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Text File - This is a simple text format.  This is the format that should be mailed to the 
SSA. 

Date- Date of the scores to export. 

Classes - More that one class can be written to a file, so select the class(es) you wish to 
write. 

Day Scoresheet / Contest Summary - Two types of scoresheets can be written.  The 
Day Scoresheet is the typical scoresheet for a single day.  The Contest Summary 
summarizes each day in the contest and is typically written after the contest is complete. 

File: This contains the name of the file where the scores will be written.   If you wish to 
change either the file’s name or location, hit the Browse... button and you can select a 
new name and/or location.  
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Chapter 8. Appendix 

Contest Procedures 
For each contest day where automatic flight log analysis is in use, follow these steps: 

1. Create a task for each class for the day.  Make sure the start and finish gates are 
set up correctly if you are using GPS controlled gates. 

2. When the pilots return from their flight, you will need to import the flight logs 
into Winscore by one of the methods listed above. 

3. If the task is a Pilot Selected Task, or a Modified Assigned Task, you will need 
to enter a landing card for the contestant before an analysis can be performed. 

4. Once the flight logs have been imported, go to the Flight Log view.  You should 
then see the pilots you just imported.  If not, make sure the class and the date are 
correct.  Select the (Flight Logs | Analyze All…) menu to analyze the flights.  
You will then see the scoring information that was determined from the flight 
log analysis. 

5. If Winscore detects a possible problem in the evaluation of the flight log, it will 
generate a warning.  The number of warnings will be listed in the flight log 
view.  When you see warnings, double-click on the flight in question and you 
will see a description of the warnings. 

6. If you have questions about how the analysis was performed, simply click on the 
flight in question, then select “View Analysis” by clicking the right mouse, and 
you will see how Winscore evaluated each point in the flight log.  To view the 
flight click on the flight, then select “Display…” from the right-click menu and 
you will see the flight trace. 

7. If you feel that Winscore’s analysis of the flight is not correct for your situation, 
you can override the Winscore analysis by clicking on the flight in question, you 
can override the results of the flight log analysis by manually entering a 
roll/start/finish time or a landing card for the contestant.  For example, if the 
analysis calculates an incorrect start time, you can enter a new start time from 
the Manage Times form.  The time you entered will override the start time 
calculated by the flight log analysis. 

IGC File Naming Convention 
The name of the IGC file has the date of the flight encoded within it.  For example, the 
file, 93dc0dn1.igc contains a flight made on March 13, 1999.  This encoding scheme is 
described in the IGC file documentation.  The import point is that if the date encoded in 
the IGC file name does not match a contest date in Winscore, Winscore will not 
recognize that flight or display that flight.  The IGC file is named by the following 
scheme: 

YMDCXXXF.IGC  
Y = Year; value 0 to 9, cycling every 10 years  
M = Month; value 1 to 9 then A for 10, B for 11, and C for 12  
D = Day; value 1 to 9 then A(10), B(11) through to V(31)  
C = manufacturer's IGC code letter (see table below)  
XXX = unique FR Serial Number (S/N); 3 alphanumeric characters  
F = Flight number of the day; 1 to 9 then A(10) through to Z(35) 

Special Use Airspace File Format 
The format of the SUA is commonly known as the “Tim Newport-Peace's Special Use 
Airspace Format”.  This format is included below for reference. 
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############################################################# 

###################### USER DEFINED  FILE ################### 

############################################################# 

# 

# This is an (almost) empty file in which you can define your own Display Data. 

# 

# All lines beginning # are considered comments and will be ignored. 

# 

# Each line consists of a Keyword and a value. These Keywords are defined 

# as follows: 

# 

# TITLE=    Sections and Sub-Sections Always commence with a line 

# beginning 

#           TITLE=. 

# 

# INCLUDE=  When a line beginning INCLUDE=NO is encountered skip all 

#           text until a line beginning INCLUDE=YES is encountered. 

#           This will normally be on the line BEFORE a TITLE= line. 

#           YES and NO are the only permitted Values. 

# 

# TYPE=     This defines the Type of Airspace. The permitted values  

#           are:          

#           Definition          Abbreviation 

#           CTA/CTR             C 

#           AIRWAYS             A 

#           RESTRICTED          R 

#           PROHIBITED          P 

#           DANGER              D 

#           OTHER               O 

#           TRAINING ZONE       Z 

#           TRAFFIC INFO        I 

#            

#           The latter two are not currently in use, but may be used at 

#           some future date. 

# 

# POINT=    This is always followed by a Lat/Long position, for example 

#           POINT=N524033 W0014380. It is important that the  

#           construction is followed exactly. If this is the first 

#           POINT= line AFTER a TITLE=, drawing will commence from 

#           this point, otherwise a line will be drawn from the  

#           previous point to this new point. The last 

#           POINT will normally be the same as the first POINT. 

# 

# CLOCKWISE or ANTI-CLOCKWISE 
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#           This is always followed by a RADIUS keyword, a CENTRE 

#           Keyword and a TO Keyword (The only valid place for 

#           RADIUS, CENTRE and TO keywords is when describing an Arc  

#           or Circle.), and describes an arc to be drawn Clockwise  

#           or Anti-Clockwise from the current  

#           position, and should be constructed as follows: 

# ANTI-CLOCKWISE RADIUS=8 CENTRE=N522734 W0014494 TO=N521948 
W0014754 

# or   CLOCKWISE RADIUS=8 CENTRE=N522734 W0014494 TO=N521948 
W0014754 

#           The units of Radius are Nautical Miles. 

# 

# CIRCLE=   Similar to Arc but with only RADIUS and CENTRE Secondary 

#           keywords. 

#           e.g. CIRCLE RADIUS=10 CENTRE=N555700 W0032227 

# WIDTH=    This Keyword describes the width of an Airway in Nautical 

#           Miles and is only used in conjunction with an AWY keyword.  

#           If no WIDTH= statement is given then 10NM will be assumed. 

# AWY=      This is like the POINT= keyword and describes a point on 

#           the centre-line of an Airway whose width has been 

#           previously given in a WIDTH= statement 

#           e.g. WIDTH=10 

#           AWY=N555223 W0042667 

# TOPS= 

# BASE=     Each section of airspace requires a BASE= and TOPS=  

#           statement in order that Air_Check can detect infringements. 

#           The BASE can be defined as a Flight Level or ALT. TOPS 

#           will normally be a Flight Level. For example: 

#           WIDTH=10 

#           BASE=2500ALT 

#           TOPS=FL245 

#           or 

#           WIDTH=10 

#           BASE=FL55 

#           TOPS=FL245 

# 

# The file must finish with the word END  

# 

# Further Examples of the use of WIDTH= and AWY= can be found in the 

# file AIRWAYS.AIR, and other Keywords in CLASS_A.AIR and CLASS_D.AIR. 

# 

# You can use this file to draw any shape you wish, for instance you  

# could draw your Base Airfield's ATZ or Runway. The following sample  

# data draws the Main Runway at Lasham. 

# 
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# NOTE: POINTs etc. are in the format (d)ddmmss [degrees, minutes, 
#      seconds and not (d)ddmm.mm [decimal minutes] as in previous 

#      issues. 
# 

INCLUDE=YES 

TYPE=TRAINING ZONE 

# 

TITLE=Lasham Runway 09/27 

# 

POINT=N511112 W0010238 

POINT=N511114 W0010238 

POINT=N511119 W0010109 

POINT=N511117 W0010109 

POINT=N511112 W0010238 

# 

# 

# End of File. Have Fun! 

# 

END 
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